
Nicolet iN5 User Guide

The Thermo Scientific™ Nicolet™ iN5 microscope lets you quickly and easily collect spectra 
of Transmission, Reflection and ATR samples, with continuous viewing of the sample during 
collection.

Contents

• Introduction tells you where to find information, explains how to turn on the microscope 
power and identifies the microscope controls.

• Microscope Basics describes the parts of the microscope and explains how to use them.

• Before You Collect Spectra explains how to prepare the microscope for data collection.

• Basic Experiments explains how to collect sample spectra.

• Sampling Accessories provides information about the accessories that are available for your 
Nicolet iN5 microscope.

• Maintenance and Service tells you where to find information about maintaining your mi-
croscope and replacing parts.

• Troubleshooting explains how to solve problems that could occur

Introduction
You should be familiar with the operation of your spectrometer and system software before 
using the microscope. You can use the microscope with Thermo Scientific OMNIC™ or 
μView™ software. For complete information on using these packages, see the Help system or 
other documentation that came with the software. In this manual, we will refer mostly to 
OMNIC commands.

The Nicolet iN5 microscope must be installed as part of a Thermo Scientific spectrometer 
system and can be used only after it is properly connected to the spectrometer.
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Conventions

Where to Find the Information You Need

Tutorials are included in the OMNIC software Help system. 

The tutorials teach you how to do these things:

• Set up your system for a variety of experiments
• Perform mathematical operations on spectra
• Create reports and report notebooks containing the results of your work
• Install optional hardware
• Change replaceable parts
• Get part number and ordering information

Microscope Basics
This section describes the major components of your microscope. It also explains how to turn 
on the microscope power, calibrate the video image, focus a sample and move the stage 
horizontally.

Microscope Components

The following illustrations identify some important components of the microscope. Refer to 
these illustrations when you use other sections of this manual. 

NOTICE    Be sure that all persons operating this system read the site and safety manual 
first.

DANGER    Indicates a hazardous situation which, if not avoided, will result in death or 
serious injury.
WARNING  Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.
CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.
Note  Contains helpful supplementary information.

Note  You must have the media: Microscope Help and Tutorials media in the ROM drive 
to view any videotaped parts replacement procedures. 
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Control Panel

The Control panel is on the left side of the microscope. 

Turning on the Microscope Power

We recommend that you keep the spectrometer power and microscope power on at all times, 
unless the building is subject to power outages or you need to perform a service or 
maintenance procedure. Leaving the system on keeps it equilibrated with the surroundings 
and gives you the most consistent results.

To turn on the microscope power, press Power switch ON/OFF.

Focusing

The Course focus and Fine focus knobs on the left and right side of the microscope let you 
raise or lower the stage (in the Z direction). Use these knobs to lower the stage before 
installing a sample and to bring a sample into focus.

• When focusing, first use one of the coarse focus knobs to bring the sample into 
approximate focus 

– The easiest way to do this is to look directly at the sample rather than through the 
viewer or at the video image

Connect optional purge 
tubing here

Connect computer
here

Power switch
ON/OFF

Connect computer
here

Connect 
spectrometer 
here

Fine focus

Course focus

Stage stop
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– You should be able to see a small, bright spot of light on the sample when it is close to 
the focal point

– Look through the viewer or at the video image (if you have a camera option) and use 
one of the fine focus knobs to focus the sample sharply

Setting the Stage Stop

Next to the focus knobs on the right side of the microscope is a ring used for setting a vertical 
stage position. You can use this ring both as a Stage stop that lets you quickly return to a stage 
position and as a safety measure to protect the microscope hardware.

 To set the stop

1. Use the Stage focus knobs to adjust the vertical position of the stage.

Normally this is the position at which a sample is in sharp focus. 

2. Lift the Stage stop handle until it feels tight. 

You can now move the stage downward—for example, to change samples—and then 
quickly return the stage to its former vertical position by turning the Course focus knob 
until the stage stops.

You can also use this feature to protect the objective and stage. First carefully move the stage 
upward until it is slightly below the bottom of the objective. Then lift the stop handle until it 
feels tight. With the stop set, you can begin working with samples without worry of hitting 
the objective accidentally when you raise the stage.

Moving the Stage Horizontally

If you have the standard manual stage, use the stage positioning knobs to move the stage 
in the X and Y directions, as shown.

Forward Backward

Left Right

Stage X
position knob

Stage Y
position knob
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Touch Point

Before You Collect Spectra 

• “Turning on the System Components” on page 6
• “Cooling the Detector” on page 7
• “Starting OMNIC Software” on page 8
• “Opening a Configuration” on page 8
• “Selecting an Experiment” on page 8
• “Setting up the Viewing System” on page 9
• “System Performance Check” on page 12

Turning on the System Components

We recommend that you keep the spectrometer power and microscope power on at all times, 
unless the building is subject to power outages or you need to perform a service or 
maintenance procedure. Leaving the system on keeps it equilibrated with the surroundings 
and gives you the most consistent results.

Your microscope uses power from your spectrometer. 

1. Turn on the microscope power. 

See “Power switch” on page 3. If the microscope has been off for several hours, allow at 
least one hour for its temperature to stabilize for best performance.

Touch Point button
(only available with the 
Nicolet iS50 spectrometer)

Note  Always follow the safety precautions described in this manual and in the 
spectrometer site and safety guide that came with your system. 
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2. Turn on the computer.

Turn on the printer and computer as explained in the documentation that came with 
those components.

Cooling the Detector

If your microscope is configured with an MCT detector, the detector requires cooling with 
liquid nitrogen before you can collect infrared spectra. If your microscope has been configured 
with a DTGS detector, no cooling is required (skip this procedure). 

1. Fill a laboratory dewar with approximately 750 mL (26 fluid ounces) of liquid nitrogen.

Less liquid nitrogen is needed if the detector was cooled recently.

2. Open the Detector fill port and insert the stem of the provided laboratory funnel into the 
hole in the Detector fill port; slowly pour the liquid nitrogen into the lab funnel until the 
detector dewar is full.

The warm funnel and detector may cause the liquid nitrogen to boil rapidly. 

• After you have filled the lab funnel three times, allow the detector dewar to cool for 
one to two minutes before adding more liquid nitrogen. 

• Continue filling the detector dewar by slowly pouring the remaining liquid nitrogen 
into the funnel. 

• The dewar is full when liquid nitrogen no longer drains into it.

• For best results, allow the detector to stabilize for at least 20 minutes before analyzing 
samples. 

• The Thermo Scientific stainless steel dewar detector will remain cold for up to 
18 hours. 

• You can add liquid nitrogen as needed at any time except when you are collecting 
infrared spectra.

WARNING  Avoid freeze burns. Liquid nitrogen is extremely cold and therefore potentially 
hazardous.

• Wear protective equipment and follow standard laboratory safety practices.

• To avoid hazardous contact with liquid nitrogen, make sure any dewar or container 
used to hold liquid nitrogen can do so safely without breaking.

• When filling the dewar, be careful not to contact the liquid nitrogen with your skin. 
Fill the dewar slowly. Cooling the detector too quickly may cause the dewar to rapidly 
boil off liquid nitrogen.
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Starting OMNIC Software

Double-click the OMNIC icon on your desktop.

Opening a Configuration

Opening a configuration lets you quickly set a number of software options. You can create and 
save your own configurations to customize OMNIC software for the way you prefer to use it. 
In OMNIC Help Topics find “configuration” in the Index and go to “Customizing OMNIC 
by setting options” for more information.

If you will be checking the performance of the microscope (explained later in this section) or 
collecting your first sample spectrum (explained in the next section), open the provided 
configuration file named DEFAULT.CON. 

1. Choose Open Configuration from the File menu.

The Open Configuration dialog box lists the available configuration files.

2. Select the file named DEFAULT.CON

3. Click Open.

Selecting an Experiment

By selecting an experiment from the Experiment drop-down list box below the OMNIC 
menu bar, you can quickly set the software parameters for the type of data collection you want 
to perform. The drop-down list contains all of the experiments you have opened, plus the 
default experiment. You can create and save your own experiments with the parameter settings 
you need for different applications. 

If the desired experiment does not appear in the Experiment drop-down list box, choose 
Experiment Setup from the Collect menu and use the Open button in the Experiment Setup 
dialog box to open the experiment. Once you have opened the experiment, it will appear in 
the Experiment drop-down list box for future selection. In OMNIC Help Topics find 
“experiment” in the Index and go to “Using Experiment Setup” for more information on 
opening experiments.

Note  If you are using Thermo Scientific EZ OMNIC™, only the current configuration is 
available. You cannot open a different configuration.

Note  Choosing either iN5 %Transmission or iN5 %Reflection through the software does 
not change the mode, this has to be done at the microscope.
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If you want to check or change the parameters after selecting an experiment, use Experiment 
Setup in the Collect menu.

Later in this section you will select (or open) the experiments needed to collect Transmission 
or Reflection sample data with the microscope.

Setting up the Viewing System

Before you collect sample data, it is important to set up the viewing system for optimum 
performance. This involves setting the μView parameters that affect the display of the video 
image of the sample and calibrating the video image. 

Setting the Video Parameters

The μView, the video parameters determine how the video driver displays the video image. 
You set the parameters by using the Video Source command in μView. For details see “Setting 
the video parameters” in the “Setting Up the Software and Display” section of the MicroView 
User Guide.

Calibrating the Video Image

The μView can be used to calibrate the video image to coordinate what is displayed in the 
video pane with the actual field of view. That is, the number of micrometers represented by 
the video pane axes must match the number of micrometers in the field of view. The 
calibration is very important. If you don’t calibrate the video image, the axes and any 
annotation such as the ruler and drawn circles and rectangles will not have correct micrometer 
values.

For complete instructions see “Calibrating the video image” in the “Setting Up the Software 
and Display” section of the MicroView Software User Guide.

Setting up the Binocular Viewer

 To set up binocular viewer (optional)

1. Set the microscope for Reflection by turning the Reflection & Transmission knob. 

2. Position a sample under the objective, and rotate the Brightness control to adjust the 
illumination to a comfortable viewing level.

= Transmission

= Reflection

= increase

= decrease
Thermo Scientific Nicolet iN5 User Guide 9



Nicolet iN5 User Guide
Before You Collect Spectra
3. Use the Stage focus knobs to obtain a sharp image of the sample.

4. Grasp the base of both eyepieces and move them until they are aligned with your eyes as 
you look through the viewer.

You should see a single, clear image of the sample through the viewer when the eyepieces 
are positioned correctly.

When you are finished, look at the reading on the scale between the eyepieces (the white 
dot indicates the numerical value). In the future you will be able adjust the eyepieces 
quickly by moving them to this reading.

5. While looking through the right eyepiece with your right eye, use the stage focus knobs to 
focus the sample image.

6. While looking through the left eyepiece with your left eye, turn the eyepiece until the 
image is in focus.

This sets the diopter, ensuring that the sample image will be in focus for both your eyes. 
The correct diopter setting will vary from person to person because of vision differences.

Grasp here
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7. While looking through the right eyepiece, focus the reticle by holding the inner ring with 
one hand and turning the outer ring until the reticle cross hairs are clear.

You can rotate the entire right eyepiece to orient the cross hairs as desired. Normally the 
cross hairs are positioned as shown.

You can use the reticle to measure distances on sample surfaces; the numerical scale is in 
micrometers. The square at the center of the reticle is the reticle reference square. You can 
use it when adjusting the aperture to the size and shape of a square 100 μm on a side.

Hold inner ring

Turn outer ring
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System Performance Check

To verify that the microscope is performing well, you should measure its performance weekly 
by checking the signal-to-noise ratio (SNR) from 2600 to 2500 wavenumbers. The 
procedures in the next sections give the desired noise level limits for both Transmission and 
Reflection. If you will be performing only Reflection experiments, you do not need to run the 
Transmission noise test.

Before you begin...

• Make sure the detector is cool. See Cooling the Detector if you need help

• Prepare the optics by following the procedures in the preceding sections

• If a camera is installed, start μView if it is not already running. 
(Refer to the MicroView Software User Guide for instructions.)

Running the Noise Test in Transmission

1. Set the microscope for Transmission by turning the Reflection & Transmission knob on 
the left side.

This directs both the visible light and infrared beam upward from below the stage, 
through the opening in the stage and to the objective.

2. Set the illumination properly by rotating the dial on the left side of the microscope.

3. Remove any slide from the stage.

4. Move the stage horizontally to position the large hole in the stage under the objective.

See “Moving the Stage Horizontally” on page 5.

5. Adjust the Condenser focus and adjust the illumination until the video or viewer image is 
moderately bright and the Transmission pin hole is in focus.

6. Select the iN5_%Transmission experiment from the Experiment drop-down list box.
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This sets the experiment parameters for collecting Transmission sample data with the 
microscope. (Later you will set three of the parameters to different settings specifically for 
the noise test.)

7. If the experiment is not available in the Experiment drop-down list box, use Experiment 
Setup to open it. Its filename is iN5_Transmission.exp. For more information, find 
“experiment” in the OMNIC Help system Index and go to “Selecting an experiment” or 
“Using Experiment Setup.”Choose Experiment Setup from the Collect menu.

The Experiment Setup dialog box appears.

This dialog box contains the experiment parameters used by the iN5_Transmission 
experiment. For complete information about the parameters, find “parameters” in the 
OMNIC Help system Index and go to “Using Experiment Setup.”

8. Set the parameters for the noise test.

a. Click the Collect tab.

b. Set Number of Scans to 200.

c. Set Final Format to %Transmittance.

d. Click the Advanced tab.

e. Set Apodization to Triangular.
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9. Click the Bench tab.

The Bench tab contains a live display of the detector signal.

The intensity of the signal is indicated by the values above the live display. If no signal 
appears, see the table in Troubleshooting section for instructions.

For more information about the live display, find “live display” in the OMNIC Help 
system Index and go to “Using the live display.”

10. Maximize the signal intensity by adjusting the condenser focus and the horizontal stage 
position.

The condenser focuses the infrared beam on the plane of the sample. To adjust the focus, 
turn the condenser focus knob until the signal intensity is greatest. You may need to turn 
the knob in both directions to find the optimum focus.

11. Click OK to close the Experiment Setup dialog box.

12. Click Collect Background on the toolbar.

Tip  When you analyze your own samples, you don’t need to focus the condenser 
before each sample unless the samples are of different thicknesses. Focusing the 
condenser before the first sample in a sequence of similar samples is usually adequate.

A message asks you to prepare for the 
background collection.
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13. Click OK.

The Collect Background window shows the background spectrum as it is collected.

14. Click No.

Even though you are not adding the background to a spectral window, it will remain in 
memory and will be used for ratioing the sample spectrum you are about collect.

15. Click Collect Sample on the toolbar.

When data collection is finished, a 
message asks whether to add the 
spectrum to a spectral window.

The Collect Sample window appears and then a 
dialog box showing the default title for the 
sample spectrum.

Progress of collection gauge
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16. Type a title in the text box or click OK to accept the default.

17. Click OK.

Collection of the sample spectrum begins. The progress of the collection is indicated by 
the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

18. Click Yes to add the spectrum to a spectral window.

Example: Sample spectrum displayed in a spectral window:

19. Use the region tool to select the spectral region from approximately 2600 to 
2500 wavenumbers.

A message asks you to prepare for the sample 
collection.
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20. Choose Noise from the Analyze menu.

Example: Typical noise dialog box

The peak-to-peak noise should be less than 0.10. The spectrometer contributes 
significantly to the performance of the microscope. (Older spectrometers that do not 
meet basic mid-IR performance standards may have a higher noise level.) If the noise level 
exceeds 0.10, make sure the spectrometer is functioning properly and then repeat this 
procedure. See the documentation that came with your spectrometer for information on 
checking its performance.

If you repeat the test, make sure these conditions are met:

• The detector is cool

• The knob on the left side of the microscope is set to Transmission

• The aperture is fully open

• The Sample Compartment parameter is set for the location of the microscope and for 
Transmission (%T)

• The condenser is focused

For more information about the Noise command, find “noise” in the OMNIC Help 
system Index and go to “Measuring noise.”

21. Click OK to close the Noise dialog box.

22. Choose Clear from the Edit menu to delete the spectrum.

Running the Noise Test in Reflection

1. Set the microscope for Reflection by turning the Reflection & Transmission knob on the 
left side.

This directs both the visible light and infrared beam downward through the objective 
onto the stage.

2. Turn the illumination all the way up.

See step 2 in the preceding procedure if you need help.

3. If you have the optional variable aperture, set the microscope aperture to a 100 μm 
square.

See step 8 in the preceding procedure if you need help.
Thermo Scientific Nicolet iN5 User Guide 17



Nicolet iN5 User Guide
Before You Collect Spectra
4. Place the provided aluminum mirrored slide on the stage.

5. Move the stage horizontally to position the aluminum mirrored slide under the objective.

See step 5 in the preceding procedure if you need help.

6. Select the iN5_%Reflection experiment from the Experiment drop-down list.

This sets the experiment parameters for collecting Reflection sample data with the 
microscope. (Later you will set three of the parameters to different settings specifically for 
the noise test.)

If the experiment is not available in the Experiment drop-down list box, use Experiment 
Setup to open it. Its filename is iN5_%Reflection.exp. For more information, find 
“experiment” in the OMNIC Help system Index and go to “Selecting an experiment” or 
“Using Experiment Setup.”While looking directly at the gold mirror (not at the video or 
viewer image), move the stage vertically to focus the spot of light on the mirror.

7. While looking at the video or viewer image, use the fine focus knob to sharply focus the 
image of the mirror.

Depending on the current position of the stage, you may have to move it up or down. 
The spot of light will be in focus when the slide is approximately one centimeter below 
the objective.

Aluminum 
mirrored slide
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8. While looking at the video or viewer image, use the fine focus knob to sharply focus the 
image of the mirror.

You should be able to see slight surface imperfections that you can bring into focus.

9. Set the parameters for the noise test.

a. Click the Collect tab if it is not already displayed in front.

b. Set Number Of Scans to 200

c. Set Final Format to %Reflectance.

d. Click the Advanced tab and set Apodization to Triangular.

10. Click the Bench tab.

The intensity of the detector signal is indicated by the values above the live display. If no 
signal appears, see the table in Troubleshooting for instructions.

For more information about the live display, find “live display” in the OMNIC Help 
system Index and go to “Using the live display.”

11. Click OK to close the Experiment Setup dialog box.

12. Click Collect Background on the toolbar.

13. Click OK.

The Collect Background window shows the background spectrum as it is collected. The 
progress of the collection is indicated by the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

14. Click No.

Even though you are not adding the background to a spectral window, it will remain in 
memory and will be used for ratioing the sample spectrum you are about collect.

A message asks you to prepare for the 
background collection.
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15. Click Collect Sample on the toolbar.

16. Type a title in the text box or click OK to accept the default.

17. Click OK.

Collection of the sample spectrum begins. The progress of the collection is indicated by 
the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

18. Click Yes to add the spectrum to a spectral window.

Example: Sample spectrum displayed in a spectral window:

The Collect Sample window appears and then a 
dialog box showing the default title for the 
sample spectrum.

A message asks you to prepare for the sample 
collection.
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19. Use the region tool to select the spectral region from approximately 2600 to 
2500 wavenumbers.

20. Choose Noise from the Analyze menu.

Example: Typical noise dialog box

1

The peak-to-peak noise should be less than 0.10. (Older spectrometers that do not meet 
basic mid-IR performance standards may have a higher noise level.) If the noise level 
exceeds 0.10, make sure the spectrometer is functioning properly and then repeat this 
procedure. See the documentation that came with your spectrometer for information on 
checking its performance.

If you repeat the test, make sure these conditions are met:

• The detector is cool

• The knob on the left side of the microscope is set to Transmission

• The aperture is fully open

• The Sample Compartment parameter is set for the location of the microscope and for 
Transmission (%T)

• The condenser is focused

For more information about the Noise command, find “noise” in the OMNIC Help 
system Index and go to “Measuring noise.”

21. Click OK to close the Noise dialog box.

22. Choose Clear from the Edit menu to delete the spectrum.

Basic Experiments 
This section will get you started collecting spectra with your Nicolet iN5 microscope. You will 
learn how to collect spectra of a solid Reflection sample, a fiber Transmission sample and an 
ATR sample. We recommend performing all three data collections, in order, to learn the most 
about using the system.

Before you begin...

Make sure the spectrometer power and microscope power are turned on. See Turning on the 
System Components in “Before You Collect Spectra” on page 6 for details.
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Make sure the detector is cool. See Cooling the Detector in “Before You Collect Spectra” on 
page 6 if you need help.

Start OMNIC if it is not running.

Start μView if it is not already running. Alternatively, if configured with optional camera, refer 
to the MicroView Software User Guide for instructions. 

Open the configuration file named DEFAULT.CON if you have not already done so. See 
“Opening a configuration” in “Before You Collect Spectra” on page 6 for details.

Reflection Experiment

When the microscope is set for Reflection analysis, you can use it to analyze samples that 
reflect infrared light. Typical infrared-reflecting samples include films and coatings on metal 
substrates. The sample must be on a reflective substrate to allow you to collect high quality 
Reflection data.

For this experiment you will need to prepare a sample slide with a thick ink spot from a 
permanent marker. 

1. Select the iN5_%Reflection experiment from the Experiment drop-down list.

This sets the experiment parameters for collecting Reflection sample data with the 
microscope. 

If the experiment is not available in the Experiment drop-down list box, use Experiment 
Setup to open it. Its filename is iN5_%Reflection.exp. For more information, find 
“experiment” in the OMNIC Help system Index and go to “Selecting an experiment” or 
“Using Experiment Setup.”

2. Set the microscope for Reflection by turning the knob on the left side.

This directs both the visible light and infrared beam downward through the objective 
onto the stage.

3. Turn the illumination to proper intensity.

Using proper illumination will make it easier to focus the microscope.

Note   If you just performed the Reflection noise test using this experiment (with 
three parameter settings changed as described in the preceding section), first select the 
iN5_%Transmission experiment and then select the iN5_%Reflection experiment. 
This will reset all the experiment parameters to their original settings in the 
iN5_%Reflection experiment in one step. 
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4. Remove the Fixed Aperture or open the optional variable aperture all the way.

a. Turn the knobs until the blades are fully open as shown.

b. Replace the variable aperture in the slot when you are finished.

If you are using the fixed aperture, do not replace in the slot.

Once you are accustomed to working with the optional variable aperture, you will 
find it easy to adjust without removing it from the slot. You will be able to see the 
aperture opening change in size and shape in the video or viewer image as you turn 
the knobs.

5. Prepare a simple sample slide. 

For example, create a thick ink dot with a permanent marker on the aluminum mirrored 
slide provided.

6. Place the prepared sample slide containing the ink spot sample on the stage. 

When you analyze your own Reflection samples, you can simply place the sample on a 
slide or tape it down if it doesn’t lie flat. Depending on the sample and the background 
material you want to use, you may need to install the sample on a slide that has a gold or 
aluminum mirror for collecting the background. In some cases the material to be analyzed 
is on top of a reflective substrate, and an exposed area of the substrate can be used for the 
background measurement.

NOTICE    

• Handle the fixed aperture and optional metal variable aperture with care.

– The blackening used to eliminate scatter can easily be rubbed off. 

– System performance can be negatively affected if the blackening is removed.

• Handle and store the apertures with care. 

– Contamination such as dust and finger oil can negatively affect system 
performance.   

– Use the air duster provided to gently remove any dust visible in the aperture 
opening.

Turn knob

Turn knob
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7. Move the stage horizontally to position the sample ink spot under the objective.

8. While looking directly at the sample (not at the video or viewer image), move the stage 
vertically to focus the spot of light on the sample.

Depending on the current position of the stage, you may have to move it up or down. 
The spot of light will be in focus when the slide is approximately one centimeter below 
the objective.

9. Move the stage horizontally to position the spot of ink under the objective.

Example: Video image of an ink spot

10. While looking at the video or viewer image, use the fine focus knob to sharply focus the 
image of the ink spot.

11. If you have a Variable Aperture option, adjust the aperture so that the opening is entirely 
within the area of the ink spot.

• Hold the aperture in place in its slot with one hand while turning the knobs with 
your other hand

Note  

• If you ever need to clean one of the provided sample slides to remove adhesive or 
other material, wipe the slide with a clean cotton cloth containing a small amount 
of methanol.

• If there is not enough clearance between the stage and the objective to install a 
large sample, you can remove the condenser so that the stage can be lowered 
further. See Removing the Condenser Before Installing a Large Sample in 
Microscope Basics for instructions.
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• Push or pull the knobs slightly to adjust the orientation of the opening

• You can also rotate the aperture within the slot

Example:

12. Move the stage horizontally so that an unmarked area of the sample is under the objective.

You will use this area to collect a background for ratioing your sample spectrum.
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13. Choose Experiment Setup from the Collect menu.

The Experiment Setup dialog box appears.

This dialog box contains the experiment parameters used by the iN5_%Reflection 
experiment. For complete information about the parameters, find “parameters” in the 
OMNIC Help system Index and go to “Using Experiment Setup.”

14. Click the Bench tab.

The Bench tab contains a live display of the detector signal.

The intensity of the signal is indicated by the values above the live display. If no signal 
appears, see “Troubleshooting” on page 50 for instructions.
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For more information about the live display, find “live display” in the OMNIC Help 
system Index and go to “Using the live display.”

15. Click OK to close the Experiment Setup dialog box.

16. Click the Collect Background button on the toolbar.

A message asks you to prepare for the background collection.

17. Click OK.

The Collect Background window shows the background spectrum as it is collected.

The progress of the collection is indicated by the gauge near the left side of the window.
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When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

18. Click No.

Even though you are not adding the background to a spectral window, it will remain in 
memory and will be used for ratioing the sample spectrum you are about collect.

19. Move the stage horizontally to position the ink so that it once again fills the aperture 
opening.

You are now ready to collect a sample spectrum.

20. Click the Collect Sample button on the toolbar.

The Collect Sample window appears and then a dialog box showing the default title for 
the sample spectrum.

Example:

21. Type a title in the text box or click OK to accept the default.

A message asks you to prepare for the sample collection.
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22. Click OK.

Collection of the sample spectrum begins. The progress of the collection is indicated by 
the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to 
a spectral window.

You can click View Collect Status to display the Results window, showing a 
summary of any problems encountered during data collection and other 
information about the collection. After you view the information, click Close.

The Collect Status indicator above the view finder shows the status of the 
collection during and after collection. When the indicator is a green check 
mark, it shows that the spectrum has passed all of the selected spectral quality 
checks made so far. In OMNIC Help Topics find “quality checks” in the Index 
and go to “Quality checks” for information on specifying the quality checks to 
perform.

If you ever have a problem with data collection while one or more quality 
checks are turned on, the Collect Status indicator may change. If the indicator is 
a yellow circle, the spectrum has failed a spectral quality check (a measured 
value was not within the allowed range), but it is not serious enough to stop the 
collection. If the indicator is a red X, there is a problem with the quality of the 
spectrum. After correcting the problem, collect the spectrum again.
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23. Click Yes to add the spectrum to a spectral window.

Here is the ink spectrum displayed in a spectral window:

The locations and intensities of the peaks in the final spectrum are unique for a particular 
sample material.

The sloped baseline of this spectrum is due to the thickness of the ink on the sample. The 
baseline of a spectrum should normally be consistent and smooth. The closer the baseline 
is to 0 log (1/R) units (100% reflectance) the better. This makes the band intensities 
easier to measure and allows you to compare spectra visually or by searching the spectrum 
against a spectral library.

Fiber Transmission Experiment

When the microscope is set for Transmission analysis, you can use it to analyze samples that 
transmit infrared light. Typical infrared-transmitting samples include fibers, films and 
biological cross sections from 5 to 15 micrometers thick, depending on the application.

For this experiment we will use the provided sample slide, on which you will mount a fiber 
sample. 

1. Select the iN5_%Transmission experiment from the Experiment drop-down list box.
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This sets the experiment parameters for collecting Transmission data with the 
microscope.

If the experiment is not available in the Experiment drop-down list box, use Experiment 
Setup to open it. Its filename is iN5_%Transmission.exp. For more information, find 
“experiment” in the OMNIC Help system Index and go to “Selecting an experiment” or 
“Using Experiment Setup.”

2. Set the microscope for Transmission by turning the Reflection & Transmission knob on 
the left side.

This directs both the visible light and infrared beam upward from below the stage, 
through the opening in the stage and to the objective.

3. Turn the illumination all the way up.

4. Open the microscope aperture all the way.

5. Prepare a fiber sample and install it on the sample slide.

You can use a fiber from the provided fiber swatch or another fiber that is similar.

You can support the sample on an infrared-transparent substrate such as a potassium 
bromide (KBr) window or lay it across the sample slide opening, securing the ends of the 
sample with adhesive tape. The sample should be thin enough to ensure that the sample 
spectrum will not have any totally absorbing peaks (peaks that are below 0.4 %T or above 
2.4 absorbance units). 

• After taping a sample to the slide as shown above, you can turn the slide over and use 
the roller tool provided with your microscope to flatten the sample on a hard surface

• A fiber sample becomes wider and somewhat transparent when flattened. 

NOTICE    If you just performed the Transmission noise test using this experiment 
(with three parameter settings changed as described in the preceding section), first 
select the iN5_%Reflection experiment and then select the iN5_%Transmission 
experiment. This will reset all the experiment parameters to their original settings in 
the iN5_%Transmission experiment in one step.

Note  If you ever need to clean one of the provided sample slides to remove adhesive 
or other material, wipe the slide with a clean cotton cloth containing a small amount 
of methanol.

Sample Sample
Window
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– You may need to roll a section of a fiber four or five times to flatten it. 

– If an unflattened fiber is 50 micrometers or more in diameter, the flattened 
section should be visible with the naked eye. 

– If the diameter of the fiber is smaller than 50 micrometers, it may help to view 
the fiber under a conventional light microscope while you roll it.

If you want to collect a spectrum with the sample between two windows, use the optional 
compression cell as explained in Micro Compression Cell and Micro Compression Diamond 
Cell Kit User Guide.

6. Move the stage horizontally to position the fiber under the objective.

7. While looking directly at the fiber (not at the video or viewer image), move the stage 
vertically to focus the spot of light on the fiber.

Since the fiber is very thin, you may need to move the stage horizontally as well to 
position the spot on the fiber.

Example: Video image of the fiber

8. While looking at the video or viewer image, use the fine knob to sharply focus the image 
of the fiber.
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9. If you are using the standard fixed aperture:

a. Center the fiber in the field of view.

b. Insert the fixed aperture in the slot. 

c. Move the X-Y knobs on the stage to ensure the fiber is centered in the aperture. the 
aperture so that the opening is entirely within the area of the fiber.

With the fixed aperture installed, you may need to move the stage from side-to-side 
to see the edges of the fiber to ensure the desired portion of the sample is centered 
within the aperture. 

10. If you have an optional variable aperture, adjust the aperture so that the opening is 
entirely within the area of the fiber.

• Hold the aperture in place in its slot with one hand while turning the knobs with 
your other hand. 

• You can push or pull the knobs slightly to adjust the position of the opening. 

• You can also rotate the aperture within the slot.

NOTICE    

• Handle the fixed aperture and optional metal variable aperture with care.

– The blackening used to eliminate scatter can easily be rubbed off. 

– System performance can be negatively affected if the blackening is removed.

• Handle and store the apertures with care. 

– Contamination such as dust and finger oil can negatively affect system 
performance.   

– Use the air duster provided to gently remove any dust visible in the aperture 
opening.
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Example: Aperture opening entirely within the area of the fiber:

11. Move the stage horizontally so that the fiber is completely outside the aperture opening.

Example:

12. Choose Experiment Setup from the Collect menu.

The Experiment Setup dialog box appears.

13. Click the Bench tab to view the live display of the detector signal.

14. Maximize the signal intensity by adjusting the condenser focus.

The condenser focuses the infrared beam on the plane of the sample. To adjust the focus, 
turn the Condenser focus knob until the signal intensity is greatest. You may need to turn 
the knob in both directions to find the optimum focus. 

Note  When you analyze a sample that is installed on a substrate, the background 
must be collected through the substrate. In that case move a clean area of the substrate 
under the objective.
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Generally, the condenser is optimally focused when the video or viewer image is at or near 
its brightest.

When you analyze your own samples, you don’t need to focus the condenser before each 
sample unless the samples are of different thicknesses. Focusing the condenser before the 
first sample in a sequence of similar samples is usually adequate.

15. Click OK to close the Experiment Setup dialog box.

16. Click Collect Background on the toolbar.

A message asks you to prepare for the background collection.

16. Click OK.

The Collect Background window shows the background spectrum as it is collected.

The progress of the collection is indicated by the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

17. Click No.

The background will remain in memory and will be used for ratioing the sample 
spectrum you are about collect.

18. Move the stage horizontally to position the fiber so that it once again fills the aperture 
opening.

19. Click Collect Sample on the toolbar.
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The Collect Sample window appears and then a dialog box showing the default title for 
the sample spectrum.

20. Type a title in the text box or click OK to accept the default.

A message asks you to prepare for the sample collection.

21. Click OK.

Collection of the sample spectrum begins. The progress of the collection is indicated by 
the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

22. Click Yes to add the spectrum to a spectral window.

Example: Fiber spectrum displayed in a spectral window:

The locations and intensities of the peaks in the final spectrum are unique for a particular 
sample material.

The baseline of the spectrum should be consistent and smooth. The closer the baseline is 
to 0 absorbance units (100% transmittance) the better. This makes the band intensities 
easier to measure and allows you to compare spectra visually or by searching the spectrum 
against a spectral library.
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ATR Experiment

The optional Slide-On ATR™ system lets you analyze highly infrared-absorbent or 
hard-to-prepare microscopic materials, often with little or no sample preparation. Examples of 
these materials include polymers, coatings, rubbers, coated papers and biological materials.

Applications of ATR microscopy include these:
• Analyzing surface defects or inclusions
• Analyzing glass-filled fibers
• Analyzing biological materials
• Analyzing surface degradation
• Performing polymer studies
• Performing quantitative analyses

Your iN5 microscope configuration may include one or more optional Slide-On ATR crystal 
sliders. The iN5 microscope is optionally available with either a germanium (GE) tip ATR or 
diamond ATR crystal. 

The Contact Alert™ System helps you achieve proper contact pressure with the crystal in an 
ATR crystal slider. During an ATR experiment, the system monitors the force between the 
sample and crystal. Indicators illuminate to show when you have achieved initial contact and 
optimum pressure.

For this experiment we will use a polycarbonate sample slide that may have been provided 
with the Slide-On ATR. If your Slide-On ATR is not provided with a polycarbonate sample 
slide, prepare a simple sample slide by taping a piece of a plastic bag to a glass slide. 
Alternatively, a prepared sample is included with the optional Polystyrene Standards Plate 
used with the ValPro™ System Qualification option.

1. Select the iN5_Reflection experiment from the Experiment drop-down list box.

Ge ATR 
slider

Diamond 
ATR

NOTICE    If you just performed the Reflection noise test using this experiment (with 
three parameter settings changed as described in the preceding section), first select the 
iN5_%Transmission experiment and then select the iN5_%Reflection experiment. 
This will reset all the experiment parameters to their original settings in the 
iN5_%Reflection experiment in one step.
Thermo Scientific Nicolet iN5 User Guide 37



Nicolet iN5 User Guide
Basic Experiments
This sets the experiment parameters for collecting ATR data.

If the experiment is not available in the Experiment drop-down list box, use Experiment 
Setup to open it. Its filename is iN5_Reflection. For more information, find 
“experiment” in the OMNIC Help system Index and go to “Selecting an experiment” or 
“Using Experiment Setup.”

2. Set the microscope for Reflection by turning the knob on the left side.

3. Turn the illumination all the way up by rotating the dial on the left side of the 
microscope.

4. Open the microscope aperture all the way.

5. Install the Contact Alert plate on the stage.

Remove the round insert from the stage and then replace it with the Contact Alert plate. 

6. Connect the cable from the Contact Alert plate to the Contact Alert connector on the 
microscope.

Contact Alert plate

Rectangular recess
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7. Place the polycarbonate sample slide, or your previously prepared slide, into the 
Rectangular recess on the plate.

8. Move the stage horizontally to position the plastic sample under the objective.

9. While looking directly at the plastic sample (not at the video or viewer image), move the 
stage vertically to focus the spot of light on the plastic.

Since the plastic is very thin, you may need to move the stage horizontally as well to 
position the spot on the plastic.

10. While looking at the video or viewer image, sharply focus the image of the plastic sample.

11. Remove the plastic cap from the ATR crystal slider, and use a laboratory tissue to wipe the 
crystal clean.

Any residue on the crystal from previous experiments could produce unwanted peaks in 
your sample spectrum.

12. Insert the slider all the way into the slot at the front of the objective.

13. Choose Experiment Setup from the Collect menu.

The Experiment Setup dialog box appears.

14. Select the Preview sample.... option.

15. Click OK to close the Experiment Setup dialog box.

16. Click Collect Background on the toolbar.

A message asks you to prepare for the background collection.

NOTICE    This will protect the ATR crystal in case too much pressure is applied when 
sample contact is made A glass slide will typically break before the ATR crystal cracks. 
Replacing the glass slide is much less expensive than the ATR crystal.
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17. Click OK.

The Collect Background window shows the background spectrum as it is collected. When 
data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

18. Click No.

The background will remain in memory and will be used for ratioing the sample 
spectrum you are about collect.

19. Click Collect Sample on the toolbar.

The Collect Sample window appears and then a dialog box showing the default title for 
the sample spectrum.

20. Type a title in the text box or click OK to accept the default.

A message asks you to prepare for the sample collection.

21. A preview of your sample spectra will appear. 

Note, there are no peaks associated with your sample present since the crystal is not in 
contact with the sample.
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22. Slowly and carefully raise the stage until the green indicator on the front of the 
microscope illuminates. 

The sample has made initial contact with the ATR crystal at this point.

23. Continue to slowly raise the stage until the red indicator illuminates–STOP 
IMMEDIATELY. 

You will have seen the spectral peak intensity of your sample increase with increased force.

NOTICE    Excessive pressure can damage the ATR crystal or crack the glass slide. Be 
sure to stop raising the stage in the next step when the red indicator illuminates. Red 
indication means you are at the maximum pressure for the ATR.

Green indicator 
illuminated

Red indicator 
illuminated
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24. Back down the stage slightly until the just the green indicator is illuminated.

The contact pressure and signal intensity is now optimum for collecting data.

25. Click Continue Collect to begin sample data collection.

The progress of the collection is indicated by the gauge near the left side of the window.

When data collection is finished, a message asks whether to add the spectrum to a spectral 
window.

26. Click Yes to add the spectrum to a spectral window.

Example: Sample spectrum displayed in a spectral window

• The baseline of the spectrum should be consistent and smooth. 

Green indicator 
illuminated
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• The closer the baseline is to 0 log (1/R) units (100% reflectance) the better

– This makes the band intensities easier to measure and lets you compare spectra 
visually or by searching the spectrum against a spectral library

• Note that ATR spectra show stronger bands at the long wavelength (lower 
wavenumber value) end of the spectrum

• You may wish to use OMNIC’s ATR correction feature to render the spectrum more 
similar in relative band intensities to a Transmission spectrum

27. Click Other Corrections from the Process menu and select ATR

28. Carefully raise stage. 

The green indicator will turn off. Continue to lower the stage to the full extent of travel.

It is now safe to remove the slider.

29. Carefully remove the slider from the objective, use a laboratory tissue to wipe the crystal 
clean; return slider to the protective packaging.

Including a Video Image in a Report

It is often helpful to include a video image of your sample in a report created with OMNIC. 
You can do this easily if you have μView.

1. Display the desired image of the sample in the video pane.

Focus the image sharply for best results.

2. Choose Copy Video Image from the Image menu of μView.

This copies the video image to the Windows™ Clipboard.

NOTICE    

• Damage to the crystal can occur while the crystal is in contact with the sample 

• The crystal cannot be in contact with sample when moving the stage horizontally or 
during removal of slider

No indicator 
illuminated
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3. Use Template in the Report menu of OMNIC to create or select a report template that 
includes a Current Clipboard Picture item or Clipboard Picture item.

• If a template includes a Current Clipboard Picture item, reports generated using the 
template will include the contents of the Clipboard at the time the report is 
generated. 

– This allows you to use the same template to generate reports for a variety of 
samples. You simply copy the desired sample video image to the Clipboard just 
before generating the report.

• If a template includes a Clipboard Picture item, reports generated using the template 
will include the contents of the Clipboard at the time the template was created. 

– This means that the video image you just copied to the Clipboard will appear in 
all reports you generate with the template in the future. 

– This item is most useful when you want your reports to include an image that 
doesn’t change; for example, a corporate logo. 

– For video images, you will probably find the Current Clipboard Picture item 
more useful.

For complete instructions on using the Template command, find “template” in the 
OMNIC Help system Index and go to the “Selecting, editing or creating a report 
template” topic. Click the How To button near the top of the topic to see a step-by-step 
procedure.

4. Use Preview/Print Report in the Report menu of OMNIC to view and print the report.

The displayed report is generated using the template that you just created or selected.

• If the template includes a Current Clipboard Picture item, the report contains 
whatever image you copied to the Clipboard most recently; in this case, the sample 
video image. 

– After you print the report or close the report preview, you can use μView to copy 
a different sample video image to the Clipboard and then use Preview/Print 
Report again to view and print a report containing that video image.

• If the template includes a Clipboard Picture item, the sample video image you copied 
in step 2 appears in the report—and will appear in all future reports generated with 
the template.

For complete instructions on using the Preview/Print Report command, find “report” in 
the OMNIC Help system Index and go to the “Previewing or printing a report” topic. 
Click the How To button near the top of the topic to see a step-by-step procedure.
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Tips for Collecting a Background

Since your background spectra can have a significant effect on the quality of your ratioed 
sample spectra, it is important to collect a background using the technique that is most 
appropriate for your application. Follow the tips below to obtain the best possible 
backgrounds for your Transmission, Reflection and ATR experiments.

• To minimize the effects of water vapor and carbon dioxide absorptions on your 
background and sample spectra, make sure the microscope and spectrometer are 
adequately purged when you collect data.

• Depending on the sample and the background material you want to use for a Reflection 
experiment, you may need to install the sample on a slide that has a gold or aluminum 
mirror for collecting the background. In some cases the material to be analyzed is on top 
of a reflective substrate, and an exposed area of the substrate can be used for the 
background measurement.

• Before you collect a background spectrum in an ATR experiment, make sure the stage is 
lowered so that the sample is not in contact with the ATR crystal. Also make sure the 
crystal is clean.

• When using a compression cell to collect Transmission data, place a single crystal of KBr 
on the cell substrate. The crystal should be about the same thickness as the sample. 
Collect the background through the crystal, making sure the apertured area does not 
extend beyond the crystal.

• If you are collecting spectra with the sample installed on a window or between two 
windows, collect the background through the same window material. This will help 
prevent offset of the sample spectrum baseline.

• Fringing occurs when the infrared beam encounters a thin region of space defined by two 
substances that don’t have the same refractive index, such as an air gap between two salt 
windows or a thin film surrounded by air. If you are sampling between two windows, you 
can eliminate or minimize fringing by placing a single crystal of KBr between the plates 
and measuring the background through the KBr crystal.

Touch Point Button

iN5 Microscope

The iN5/iS50 Interface Bracket contains a Touch Point button that allows the user to easily 
switch to the microscope beam path. Additionally, the button enables easy integrated 
sampling while viewing your sample through the eyepieces.

Touch Point button (only available with the Nicolet iS50 spectrometer). This button 
automatically configures the spectrometer for microscope sampling. The Touch Point LED 
shows the status of the ATR module and has three states:
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The microscope spectral range options are the same as for the spectrometer and are dependent 
upon the spectrometer configuration. Refer to the spectrometer help topics or iS50 ATR 
Module user guide for more information.

Removing the Condenser Before Installing a Large Sample

If you find that there is not enough clearance between the stage and the objective to install a 
large Reflection sample, you can remove the condenser so that the stage can be lowered 
further. (The condenser is not used in a Reflection experiment.)

Before you start:

• Maximize the signal by adjusting the condenser focus knob

• Make a record of the detector signal intensity obtained with the microscope set for 
Transmission and with no sample on the stage

The signal intensity appears above the live display on the Bench tab of the Experiment 
Setup dialog box

• Display the intensity as a peak-to-peak value by selecting Peak To Peak to the right of the 
live display

• After you reinstall the condenser, you will maximize the signal again and compare it with 
the recorded value to make sure the condenser is installed correctly

 To remove the condenser

1. Remove any sample from the stage

2. Use the Course focus knob to raise the condenser stage to its highest position.

3. Use the Condenser focus to lower the condenser to its lowest position.

LED status Meaning

On Ready for use

Off System is not configured for microscope sampling

Blinking Optics are reconfiguring

NOTICE    Be careful not to hit the objective with the stage when you raise the stage.
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4. Loosen the captive thumbscrew all the way.

5. Use the stage positioning knobs to move the stage all the way to the back.

This moves the Stage positioning knobs out of the way so that you can remove the 
condenser in the next step.

6. Carefully slide the Condenser out through the opening at the right.

You can now lower the stage and install your sample. 

Reinstalling the Condenser

 To reinstall the condenser

1. Remove any sample from the stage.

2. Use the Course focus knob to raise the stage to its highest position.

3. Use the Stage positioning knobs to move the stage all the way to the back.

4. Carefully slide the Condenser into position from the right.

The bracket containing the captive thumbscrew should still be in its lowest position. If it 
is not, use the condenser focus knob to lower it all the way.

5. Secure the condenser with the captive thumbscrew.

a. Position the condenser so that the screw hole aligns with the thumbscrew. 

b. Hold the condenser with your right hand while tightening the thumbscrew with your 
left hand. 

Do not tighten the thumbscrew more than finger-tight or performance may be 
compromised.

NOTICE    To prevent damage to the internal mirror, avoid inserting your finger or any 
other object through the opening on the top of the condenser.

Captive 
thumbscrew

Setscrews

NOTICE    Be careful not to hit the objective with the stage when you raise the stage.
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6. While watching the live display on the Bench tab of the Experiment Setup dialog box, use 
the condenser focus knob to maximize the detector signal. 

7. Adjust the condenser Setscrews slightly in either direction to maximize the detector signal 
again.

The signal intensity you achieve should be within plus or minus 20% of the value you 
recorded before you removed the condenser. If it is not, try removing and reinstalling the 
condenser as described above.

When you are finished, the microscope is ready for use.

Sampling Accessories
This section describes the types of sampling accessories offered by Thermo Scientific. Be sure 
to read the manual that came with the accessory, if one was provided.

Compression Cell Accessory

The optional compression cell lets you easily flatten and install infrared-transmitting samples, 
such as fibers, films, chips and beads up to 15 micrometers thick. The cell reduces the 
thickness of samples that are too thick and also helps hold small samples in position. You can 
also use a compression cell to analyze powders and liquids.

For directions on using the Compression Cell, refer to the “Micro Compression Cell and Micro 
Compression Diamond Cell Kit User Guide.”

For ordering information, point to Microscope in the Help menu of OMNIC, choose 
Replacing Parts and then view “Ordering parts” in the “Ordering parts” book. 

ATR Sampling Accessories

Germanium (Ge) and diamond ATR crystal sliders are available for performing ATR 
experiments with your microscope. The crystal material type affects the depth of penetration 
of the infrared beam into the sample. You can also purchase replacement crystals for the 
sliders. 

For ordering information, point to Microscope in the Help menu of OMNIC, choose 
Replacing Parts and then view “Ordering parts” in the “Ordering parts” book.
48 Nicolet iN5 User Guide Thermo Scientific



Nicolet iN5 User Guide
Maintenance and Service
Maintenance and Service
For information on maintaining and servicing your microscope, point to Microscope in the 
Help menu of OMNIC, choose Replacing Parts and then view the topics in the “Service and 
maintenance” book. Also see “System Performance Check” on page 12 in the Before You 
Collect Spectra section of this manual.

NOTICE    Refurbishment of the blackening on the fixed aperture or optional variable 
metal aperture can be easily performed using a household candle. The optional variable 
glass aperture does not require blackening.

• Clean the aperture with isopropyl alcohol.   

• Hold the aperture briefly over the flame of the candle. 

– Repeat until a uniform deposit of soot appears around the hole in the aperture. 

• Repeat this process on the opposite side of the aperture. 

• Inspect under magnification to ensure aperture is clear of soot particles. 

• Remove soot particles with a household pin or equivalent sharp object.

Examples of 
dust particles

Before cleaning After cleaning
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Troubleshooting
The following table describes some problems that could occur when you use the microscope 
and explains how to solve them. If you are unable to solve a problem after following the 
instructions here, contact us.

Problem Possible Cause Solution

The noise test failed. The microscope is not 
focused.

The spectrometer is not 
functioning properly.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.

Check the operation of the 
spectrometer. See the 
documentation that came with the 
spectrometer for details.

No image appears. The microscope is not 
focused.

The illumination is too low.

The illuminator is not 
receiving power.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.

Increase the illumination with the 
illumination knob.

Make sure the microscope power 
switch is turned on.

The image is blurred The microscope is not 
focused.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.
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The signal is weak 
without a sample in 
the beam path.

The microscope is not in the 
correct mode.

The microscope is not 
focused.

The detector is not cooled.

The experiment parameters 
are not set correctly.

Set the microscope to Transmission 
or Reflection as needed.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.

“Cooling the Detector” on page 7. 
Allow at least 10 minutes for the 
detector to cool.

Make sure the Sample 
Compartment, Detector, Aperture, 
Velocity and Gain parameters are 
set correctly in the Experiment 
Setup dialog box.

Problem Possible Cause Solution
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No signal appears in 
the live display.

The microscope is not in the 
correct mode.

The microscope is not 
focused.

The detector is not cooled.

The beam path is blocked or 
not set correctly.

The aperture is not adjusted 
correctly.

The external camera cable is 
disconnected.

The USB cable is 
disconnected.

The spectrometer cable is not 
securely attached to the 
spectrometer connector on 
the control panel.

Set the microscope to Transmission 
or Reflection as needed.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.

“Cooling the Detector” on page 7. 
Allow at least 10 minutes for the 
detector to cool.

Remove any foreign objects from 
the beam path. Make sure the 
Sample Compartment parameter 
in the Experiment Setup dialog 
box is set for the microscope mode 
and location.

Adjust the aperture.

Connect the external camera cable 
between the camera and the 
microscope body.

Connect the USB cable between 
the control panel and the 
computer.

Attach the cable.

Problem Possible Cause Solution
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The signal is weak 
with a sample in the 
beampath.

Sample focus stage 
drifts out of focus.

The microscope is not in the 
correct mode.

The microscope is not 
focused.

The detector is not cooled.

The condenser thumbscrew 
has been overtightened (for 
Transmission experiments 
only).

The experiment parameters 
are not set correctly.

The infrared energy level in 
the spectrometer is low.

The sample was not properly 
prepared.

Sample stage focus knob 
tension is not set properly.

Set the microscope to Transmission 
or Reflection as needed.

Focus the microscope. For 
Transmission experiments, be sure 
to check both the sample and 
condenser focus.

“Cooling the Detector” on page 7. 
Allow at least 10 minutes for the 
detector to cool.

Make sure the thumbscrew is not 
overtightened.

Make sure the Sample 
Compartment, Detector, Aperture, 
Velocity and Gain parameters are 
set correctly in the Experiment 
Setup dialog box.

Set Sample Compartment to Main 
and check the signal intensity on 
the Bench tab of the Experiment 
Setup dialog box. If it is low, make 
sure the sample compartment is 
clear and then align the 
spectrometer. If the problem 
persists, check the spectrometer 
source power. See the 
documentation that came with 
your spectrometer for more 
information.

Prepare the sample properly. For 
example, a Transmission sample 
should not be too thick.

Increase sample stage tension.

Problem Possible Cause Solution
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To Set the Tension

1. Hold left side course focus knob firmly with your left hand.

2. Simultaneously, grasp the right side course focus knob with your right hand.

3. Turn the right side knob clockwise to increase the tension or counterclockwise to decrease 
the tension.

4. Test to ensure you have achieved the desired tension. 

5. Repeat process, as needed.

Contact Us

Technical Support: www.thermofisher.com

Thermo Fisher Scientific Inc. provides this document to its customers with a product 
purchase to use in the product operation. This document is copyright protected and any 
reproduction of the whole or any part of this document is strictly prohibited, except with the 
written authorization of Thermo Fisher Scientific Inc.

The contents of this document are subject to change without notice. All technical 
information in this document is for reference purposes only. System configurations and 
specifications in this document supersede all previous information received by the purchaser. 

Thermo Fisher Scientific Inc. makes no representations that this document is complete, 
accurate or error-free and assumes no responsibility and will not be liable for any errors, 
omissions, damage or loss that might result from any use of this document, even if the 
information in the document is followed properly. 

This document is not part of any sales contract between Thermo Fisher Scientific Inc. and a 
purchaser. This document shall in no way govern or modify any Terms and Conditions of 
Sale, which Terms and Conditions of Sale shall govern all conflicting information between the 
two documents.

NOTICE    Too little tension will allow the stage to drift downward under its own 
weight and weight of the sample, causing your sample to go out of focus.
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